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I. Accessing the Databases
You will need to visit three separate sites in order to enter all the data associated with a
given transect.

A. Private Landowner Contact Information
To record information regarding private landowner contacts, visit
https://fc.rmbo.org/Default.aspx. Once there, you will need to log in and click on the
“Landowner Database” link.

B. Transect Description Information
To update transect description information, open the data entry folder that was provided
to you by your crew leader and open the transect.htm file in Firefox (do this by right-
clicking on the “transect.htm” file and select “Open with” > “Firefox”).

C. Survey Information
In order to enter data collected during a survey you will need to open the data entry
folder that was provided to you by your crew leader and then open the “index.htm” file in
Firefox. The first time you use the data entry program you will need to be online so that
the program can download the necessary files from the database. Once the program has
downloaded the files, you can enter data either on or offline.

II. Installing and Updating the Data Entry Application

A. Installation
When your crew leader sends you the zipped data entry application folder, right-click on
the zipped folder and select “Extract Files” or “Extract All”. Set the destination to your
Desktop and hit OK. You should now have a folder called “Data Entry” saved on your
desktop. Within this folder you'll find the two .html applications that are described in the
previous section. You'll also see several folders. The only folder you will need is the
Data Entry Protocols folder which contains this data entry protocol as a PDF.

B. Updates

The data entry application can go through periodic changes during the field season to
5 improve compatibility for all avian monitoring programs and to
{ increase functionality. The data entry system has been designed
to notify users if a new version is available when the program is
opened. If, while you are online, you receive a notification
(pictured left) that there is a new version of the data entry site
available, please follow these steps to update the app:

Your version: 20130602
Latestversion: 20140203

Hit OK.

Another window will pop up to reconfirm the update. Hit OK again.

A pop-up blocker notification may appear on the top of the screen. Click on the
pop-up blocker notification, select “Options”, and select “Show http://rmbo.org/v2...”
Select “Save File” and Hit OK.

Close the Firefox browser containing the data entry application.

Extract the new Data Entry files, setting your Desktop as the destination folder.

If done correctly, another window will pop up asking if you want to replace the old
Data Entry folder with the new one. Select “Yes” every time it asks you if you
want to replace a file within the folder (or “Yes to All” if that’s an option).

wN e

No o s
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8. NOTE: The take away message here is to replace the old Data Entry folder
with the new Data Entry folder, no matter what you’ve called it or where it's
saved. By saving the latest version to the same location on your computer, your
browser will retain links to any saved transects that you have previously entered
and you will not lose any data.

[ll. Data Categories
The data entry can be broken up into 6 major sections:

A)

B)

C)

D)

E)

F)

Landowner Contact Information
Where all communication with private landowners should be recorded

Transect Description
Directions to the transect, notes about the transect, camping locations, etc.

Transect Visit Data
Observer, transect name, date, start and end times, sky, wind, temp, etc.

Point Visit Data
The points visited during the survey, point count start times, gps accuracy, reasons
points were not surveyed

Vegetation Data
Vegetation and other point information such as the presence/absence of prairie dogs

Bird Data
Species recorded at the point and information related to the observation such as
detection type, sex, distance from observer, etc.

IV. Entering Data

A)

Landowner Contact Information

To access the Landowner Database go to: https://fc.rmbo.org/Default.aspx and login.
Next, click on the link for the Landowner Database. To find a landowner by name, find
the search box in the upper left hand corner and type any part of the landowner’'s name
or business. To find a landowner by transect, use the transect drop down box in the top
right corner. To view information or update the contact log for a particular landowner
click on the landowner’s name. To add contact information click on the button at the top
of the screen labeled “View Contact Log” and type a description of the contact/contact
attempt in the text box and click on the “Add Note” button (pressing the “Enter” key will
not add your comment to the log).

Please be specific when recording contact information. Try to include whether or not you
spoke with someone or if you reached their voicemail, whether or not you left a
message, and what the outcome of the correspondence was. For example, “Called and
left message on voicemail asking Frank to call me back” is more informative than
“Called, no answer”. Each contact note will be given a date/time stamp as well as your
name. If you are unable to add the note to the contact log immediately after the
correspondence, please include the date and time of when the contact was
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made/attempted in the note since the time stamp will not reflect the actual time of the
correspondence.

B) Transect Description
To record or edit transect description information, go to the Data Entry folder provided by
your crew leader and open the “transect.htm” file with Firefox. Select the “Load a
Transect” button at the top of the page, choose the appropriate transect from the
dropdown menu and hit “Load”. If the transect has been surveyed in past years, this
page should already be filled out. Only the fields that are displayed in white are available
for editing. For all transects, make sure that the following information is entered and
accurate. When you are finished entering your information, hit the “Save Transect”
button at the top of the page.

Transect Identifiers
1. Transect Name: You may enter a short descriptor for the transect if you wish.

Transect Access

1. Access Point Info: Enter the UTM zone (number only), easting (X), and northing
(Y) of the access point (where you parked your vehicle to access the transect) if
it is different from previous years. Note: Do not include the letter portion of
the UTM zone when entering UTMs or you will be unable to save your
transect description.

2. DL Page: Enter the page number and coordinates from the Delorme (e.g., if the
transect can be found on page 12, at the coordinates B4, then enter 12 B4).

3. Accessibility: From the drop-down menu, select what type of vehicle is required
to get to the access point. Your choices are: all vehicles, high-clearance, or 4AWD
only. If a transect requires both high-clearance and 4WD please select 4WD.

Transect Information

1. Directions: It is absolutely crucial to have detailed and accurate directions to
every transect. If you conduct a survey for the first time, please make sure to
provide UTMs of the most logical and efficient location from which to access
each transect. This location should be recorded as the Access Point (AP) and is
the end point for the driving directions you provide. Also, be explicit in your
description of the AP itself. The AP should be an easily recognizable feature on
the landscape (e.g., a cattle guard, sign post, parking turnoff). Driving directions
should begin at a major landmark readily found on a map (e.g., town, major
intersection, etc.) and end at the AP. Record mileages from intersections or other
landmarks using your odometer to the nearest 1/10 of a mile.

If the directions you received for a transect are incomplete or inaccurate, enter
correct directions into the database. Please do not simply record your directions
in addition to the existing incorrect directions. This will make it difficult for the
technicians in subsequent years to determine which set of directions to follow.

Finally, provide directions from the AP to the logical first point count location on
the transect.

Example: From the junction of US-89 and US-69 in Prescott, AZ head North on
US-89 for 34.8 miles. Turn right onto Drake Road and follow this road 6.5 miles
past the quarry. Turn right onto FR 182 and drive another 0.9 miles, just past
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where the electric fence crosses the road. This is the Access Point. Point 4 is
1.79 km E from the AP. Easy hike in, ~1/2 hour.

2. Transect Description: This section allows you to provide information outlining
what a future technician should expect when surveying a transect. This should
include notes on habitat type(s), slope, useful landmarks, vegetation, terrain, and
tips on how to navigate between points where applicable. Record any points that
are inaccessible and why (i.e. on a steep cliff, in the middle of a lake, etc.). If
there is a preferred survey order due to terrain or other reasons, record that
information here as well. Please refrain from recording specific bird species
detected on the transect as this can bias future survey data.

Example: Moderate transect with rolling hills dominated by Pinyon-Juniper.
Suggested order of points: 16-13, 9-12, 8-6, 2-4. Points 1 & 5 inaccessible due to
cliffs.

3. Notes/camping: Record any other important or interesting information here, such
as wildlife encounters or road conditions. Please also record the location at which
you camped the night before conducting the survey, available amenities (if any),
and the cost. Please include the UTMs of the camping site if different than the
AP. It is also helpful to know if camping at the AP is an option and if any
alternatives are available in the area. Information on local services such as fuel,
libraries, etc. is also helpful.

Example: Points 13-16 are owned by Anne and Timothy Scott. Contact them the
day before at 820-999-8888. Remaining points are public - USFS. Camp at the
AP or at one of several dispersed camping sites with fire pits and picnic tables
located along FR 182. Nearest library is located in the town of Prescott.

4. Access Difficulty: Enter a number corresponding to the appropriate level of
difficulty in traveling from the AP to the first point of the survey (usually the
closest point). Use the following key for Access Difficulty ratings:

1] < 3 km and easy topography. Hike to transect requires less than 45 minutes.
2] 3 km - 6 km with relatively easy topography. Hike to transect requires less
than 75 minutes.
[ 3] 2 6 km and/or difficult terrain. Transect likely requires backpacking into
transect the day before.
[ 4] Transect is inaccessible due to river, cliffs, or other dangerous terrain.

[
[

5. Transect Difficulty: Enter the number that corresponds to the appropriate level of
difficulty when traveling between points on the transect. Use the following key for
Transect Difficulty ratings:

[ 1] Relatively flat transect. 16 points are easily surveyed in approx. 4 hours.

[ 2] Hilly terrain, areas with dense vegetation, and/or a few stream crossings.
Technician might not be able to complete all 16 points during the sampling
period.

[ 3] Steep slopes, dense vegetation, or difficult stream crossings throughout the
transect. Technician is unlikely to complete 12 or more points during the
sampling period.

ROCKY MOUNTAIN BIRD OBSERVATORY
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[ 4] Transect has cliffs, rivers, or other dangerous terrain that do not permit 6
points to be finished.

C) Survey Data
Transect Visit Data, Point Data, Vegetation Data, and Bird Data should all be entered by
opening the browser file entitled “index.html” with Firefox. If Firefox is not your default
browser, right-click on the index.html file->Open with->Firefox. You can also set Firefox
to be the default browser for that file (right-click->Open with->Choose default program).

Survey data can be entered offline and then subsequently uploaded into RMBO'’s
database. BE SURE to upload any data that you enter as soon as you have internet
access; otherwise, your data entry efforts may be lost (since no one else can upload the
information you’ve entered without your computer).

The occasion may arise where the data recorded on the datasheet seem incorrect or are
missing. Under no circumstances should you enter any values other than those recorded
on the datasheet or those values which are designated below to indicate “missing
values”. If you run into a problem where you must enter a value and do not know what to
enter, please contact your crew leader or Chris White (chris.white@rmbo.org).

When entering data, we recommend that you use the “Tab” button to move from one field
to the next across rows. To return to the previous cell you can use “Shift + Tab”.

Getting Started

The first time you open the index.html file you will need to be online so that the program
can download the necessary files from the database. Once the program has downloaded
the files, you can enter data either on or offline. Upon opening the index file you will be
prompted to select from the following options:

e Data Entry Mode: IMBCR, IMBCR (variable points), Parks, Tamarisk, Habitat, or
Wintering Grasslands.

e Language: English or Spanish

e Species code mode: 4 or 6

e Vegetation code mode: 2 or 6

At training, your crew leader will instruct you on which modes you should use for your
project. Select the desired modes and then click “Load”. Next, you should select either
“New Visit” or “Saved Transects”. If you are entering data for a new transect select “New
Visit”. If you are going to be entering data for a transect that you have already started
entering data for, select “Saved Transects”. If you need to enter data for a transect that
you or someone else already started entering and you don’t have that transect available
from your list of saved transects, you will need to contact your supervisor for a data
editing password. With that password you can access transect data that resides within
the database.

When entering survey data offline, the information you enter is actually saved within the
Firefox browser. This means that if you clear your browser history, you will lose any
saved data not yet submitted to the database. We recommend that you check your
browser settings and make sure you do not clear your browser history until you have
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successfully uploaded all your data to the online database. Go to Options—>Privacy Tab
and in the History section, set the “Firefox will” option to “Remember History”.

Visit Data

When you start a new transect visit or open a saved transect, the app defaults to this
page. If you ever need to navigate back to this page, click on the “Visit Data” button on
the left side of the screen.

1.

9.

Observer — Enter the observer’'s name using the drop down menu. The observer
is the person that collected the data. In the event that two surveyors collected
data for a single transect in one morning, enter one observer name in the
Observer box and the other observer’'s name in the Observer 2 box. (Required)
Date — Enter the date on which the survey was conducted as yyyy-mm-dd by
typing in the appropriate digits. (Required)

GPS Unit # — Enter the four digit number located on the silver property tag of the
GPS unit that you used to complete the transect. If you are using a personal GPS
unit or a GPS that does not have a silver property tag on it, please enter “0000”.
Transect ID — Select a Transect ID from the drop-down list. (Note: if you click in
the box and then type “c” the list will jump to the Colorado transects, or type “w”
and it will go to the Wyoming transects). (Required)

Observer 2 — Refer to the Observer field above

Who Collected? — Select the name of your employer from the drop down menu.
(Required)

Data Entry — Enter your first and last name ONLY. Please be sure to enter this
even if you were the observer for this transect visit. Make sure you are being
consistent with your name (i.e., use the same capitalization scheme, don’t enter
“Andy” for one survey and “Andrew” for another). The data entry field should be
the same for all surveys entered by an individual. Do not include any other info
besides your first and last name.

Time — Enter the start and end time of the survey using 24 hour, hhmm format
(e.g. 0545, 1019, etc.). There is no colon and the time must be 4 digits. Enter a
zero in the first place holder if the time is between 1 AM and 9 AM. If no time was
recorded on the datasheet, enter “0000”.

Sky — Enter the sky information recorded at the start and end of the transect. If
no sky information was recorded, enter “-1”.

10. Wind — Enter the wind information recorded at the start and end of the transect. If

no wind information was recorded, enter “-1”.

11. Temp — Enter the temperature in degrees Fahrenheit recorded at the start and

end of the transect. If no temp was recorded, enter “-99”.

12. Notes — Record any notes written in the “Notes” section of the data sheet. Do

not use hard returns when typing notes to preserve formatting in our database.

Points Completed

To enter Point Data click on “Points Completed” located on the left side of the screen. Add
any necessary rows for individual points on the survey (even if you did not survey that
point) by clicking the “Add Point Visit” button at the top of the screen.

1.

2.

Point — Enter the point numbers in numerical order that exist for the associated
transect. This will make it easier for us to proof the data after the field season.
Start Time — Enter the start time for each point from the Bird Datasheet in the
format hhmm (e.g., 0545) (Note: there is no colon and time must be four digits.

ROCKY MOUNTAIN BIRD OBSERVATORY
Conserving birds and their habitats 7



2015 Data Entry Protocol

Enter a “0” in the first place holder if the time is between 1 AM and 9 AM). If no
time was recorded on the datasheet for a given point enter “0000”.

GPS Accuracy — Enter the accuracy of the GPS location that was recorded on
the Vegetation Datasheet in meters. If no accuracy was recorded on the
datasheet enter “-1”.

Completed — Select a reason why the point was not completed from the drop
down menu if you did not survey the point. This information can be found on the
back of the Vegetation Datasheet. By default each point is set as “completed”. If
the point was not conducted and there is no code recorded on the datasheet for
why it was not done enter “O” for other and record “unknown” in the Notes
section next to that point.

Notes — This section should be used when you select “Other” as a reason the
point was not completed. Explain why the point was not completed in the Notes
section.

Vegetation Data

Not all study designs include vegetation data. Please make sure you’ve chosen the
appropriate Data Entry Mode when opening the data entry app. If you are in the wrong
mode, you may be asked to enter vegetation data when not necessary or vice versa.

To enter vegetation data, click on the “Vegetation Data” button located on the left side of
the screen. After completing the Points Completed Section, you can quickly generate the
necessary rows by selecting Edit->Copy rows from points completed. You can also enter
rows individually from the Edit menu. Enter all the vegetation information for each point
following the directions below.

1.

2.

Noo,rw

10.

Private Property — Check this box for each point that is on private property.
Otherwise, leave blank.

Primary Habitat — Enter the two letter code or select the code from the drop down
list that corresponds to the primary habitat that was recorded. If this field was left
blank or a two letter code was recorded that does not match any of the options in
the drop down menu please select “XX — Not recorded”.

Midstory — Check this box if it was checked on the datasheet.

Cliff/Rock — Check this box if it was checked on the datasheet.

P. dog Town — Check this box if it was checked on the datasheet.

P. dogs present? — Check this box if it was checked on the datasheet.

# of Snags — Enter the number of snags that were recorded at each point. If there
were no snags present enter “0”. If the field was left blank on the datasheet enter
“-17.

Overstory % — Enter the percentage of canopy cover, rounded to the nearest
integer. Do not include decimals. If there was no canopy cover present, enter “0”.
If canopy cover percent was not recorded enter “-1”.

Overstory mean height (m) — Enter the estimated mean height of the canopy,
rounded to the nearest meter. If the observer recorded a height to the first
decimal place, round the height to the nearest whole number. Round up if the
first decimal place value is 0.5 or higher. If there was no overstory cover present
enter “0”. If there was no canopy height recorded enter “-1”.

Overstory species and abundance — Enter the two letter code of each species
followed by its percentage abundance as a whole number. Leave this section
blank if there are no overstory species present. If you recorded a known species
that isn’t on the list of acceptable two-letter codes, enter “XX” into the database

ROCKY MOUNTAIN BIRD OBSERVATORY
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and record the species in the notes section of the visit data tab. If a transect has
more than one species recorded as “XX” please enter a note that includes the
species and point(s) where it occurred (e.g., overstory species 1 — XX = Western
Red Cedar for points 1,5,14; overstory species 3 — XX = Western Larch for points
3 and 9). If you recorded an unknown species in the field, enter “OT” into the
database.

11. Shrub cover % — Enter the percentage cover of the shrub layer to the nearest
integer. Do not include decimals. If there was no shrub cover present, enter “0”. If
shrub cover percent was not recorded enter “-1”.

12. Shrub mean height (m) — Enter the estimated mean height of the shrub layer, to
the nearest 0.25 meter (e.g., 0.25, 0.50, 1.50, etc.). If there was no shrub cover
present enter “0”. If no shrub height was recorded enter “-1”.

13. Shrub species and abundance — Enter the two-letter code of each species
followed by its percentage abundance as a whole number. If you recorded a
known species that isn’t on the list of acceptable two-letter codes, enter “XX” into
the database and record the species in the notes section of the visit data tab. If a
transect has more than one species recorded as “XX” please enter a note that
includes the Species and point(s) where it occurred (e.g. shrub species 1 — point
1 XX=False Azalea; shrub species 2 XX=Snowbrush). If you recorded an
unknown species in the field, enter “OT” into the database.

14. Ground Cover — Enter the percentages to the nearest integer of each ground
cover category: Snow; Water; Woody; Dead and Down; Herbaceous; Barellitter;
Dead Standing Grass; and Live Grass. If data are not recorded for any category
enter “-1”.

15. Dead Standing Grass Height and Grass and Herbaceous height (cm) — Enter the
average height in cm of dead standing grass and live grass and herbaceous in
the appropriate columns. If there is no dead standing grass or grass and
herbaceous cover present enter “0”. If dead standing grass or live grass and
herbaceous cover was present and the corresponding height was not recorded,
enter -1.

Bird Data

To enter Bird Data click on the “Bird Data” button located left side of the screen. Add blank
rows from the Edit button at the top of the screen and select the number of rows you’'d like
to add (1, 10, or 50). Use the tab button to move from left to right through the fields. Note:
when entering 88 bird detections enter the point that the observer was coming from in
the “Point” column and record the “Minute” as “88”.

1. Point — Select the point number that corresponds to the bird records you are
entering. When entering data for an 88 bird detected between points, you will
need to associate the data with a point. Select the point you came from as the
point number for 88 birds. (Required)

2. Minute — Enter the minute when the bird was detected (1-6). If the bird was
recorded between points, select “88” for minute (and make sure you select the
point you came from as the point number). If no minute was recorded for the bird
detection enter “-1”. Make sure you have entered all of the bird detections for the
current point before moving on to the next point.

3. Species — Enter the four-letter bird code for the bird detection. To quickly find the
species you want, while the drop-down list is selected, type the four letter code of
the species to automatically select its name. Verify you have selected the correct
species, mistakes are commonly made here (e.g., HOWR not HOWA). Press
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enter or tab to save your entry and move to the next field. When entering “NOBI”
records, the data entry system will automatically fill in the Distance, How, Sex,
and Cluster Size fields. If the bird code was left blank on the datasheet enter
“UNBI”. (Required)

4. Distance — Enter the distance from the observer to the bird in meters (whole
numbers only). If no distance was recorded on the datasheet or if the bird was
recorded between points, enter “-1”. (Required)

5. How — Enter the code for how the bird was initially detected from the drop down
menu. Note: If the bird was detected by any means other than singing or flying
over and then was heard singing, there should be a two-letter code to enter (i.e.,
VS, CS, OS). If the bird was first detected singing, then you should only have one
code to enter (S). If a bird is detected flying overhead and is then heard singing,
it is not a flyover. Just enter the detection as “S”. If the how code was not
recorded on the data sheet enter “U”. (Required)

6. Visual — Check this box if the Visual box was checked on the data sheet either by
using your mouse or by tabbing to this field and pressing the space bar.

7. Sex — Enter the sex as it was recorded on the data sheet. If Sex was not
recorded on the datasheet enter “U”. (Required)

8. Migrant — Check this box if the Migrant box was checked on the datasheet either
by using your mouse or by tabbing to this field and pressing the space bar.

9. Cluster Count — Enter the number recorded on the datasheet. If Cluster Count
was not recorded on the datasheet enter “1”. (Required)

10. Cluster ID — Enter the letter recorded on the datasheet. If Cluster ID was left
blank on the data sheet leave this field blank.

Before moving on to the next point, make sure you have entered the same
number of birds as are recorded on your datasheet and that the Point, Minute,
Species, Distance, How, Visual, Sex, Migrating, Cluster Size and Cluster Code
are all filled in correctly. Verify that you have entered all time periods including
NOBIs for minutes without birds.

To quickly delete all blank rows once you are done entering bird data, go to
Edit>Remove empty rows.

Hint: Remember to use the tab button to move from one cell to the next.

Saving your entered survey data

You can save your data entry progress by selecting File->Save Transect Visit at the top of
the screen. You can save your entered data at any time from any of the data entry pages.
NOTE: You will need to delete any empty rows from the bird data tab before saving.

Editing entered data/Completing a partially entered transect

When you save entered data on your computer, that information is saved within the Firefox
browser specifically on your computer. To edit or modify a transect that you have
previously entered data for you must open up the index.htm file on the same computer that
you entered the data on. Select the appropriate data entry mode and then select the
“Saved Transects” button on the left side of the screen. A drop down menu will appear
with the dates, transect names, and observer(s) for any transects that you have entered
on the computer you are using. Select the transect that you would like to modify. You can
make changes just like when you enter data for a new visit. Please remember to save your
work.
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Uploading entered data to the database

Once you have entered all of the data for a transect and have internet access, you should
upload your data to the online database. First, load the saved transect by clicking on the
“Saved Transects” button on the left side of the screen. A drop down menu will appear
with the dates, transect names, and observer(s) for any transects that you have entered
on the computer you are using. Select the transect that you would like to upload and hit
OK. Next, hit File=>Submit Transect Visit.

You can submit a transect multiple times. In the event that you submit a transect and then
realize that you need to make edits to the uploaded data, you can simply edit the transect
as described above and re-submit the transect. A warning message will ask if you want to
overwrite an existing transect. Be sure you know what you are overwriting before you
press “Yes”! NOTE: If you enter data while connected to the internet, it is not necessary for
you to save the transect before clicking the “Submit Transect” button. Your data will be
saved automatically prior to the submission. You will receive a pop-up message telling you
that the data have been successfully uploaded.

If you receive a warning message that the submission failed, relax. The information you
entered will have already been saved on your computer and can be recovered at any time
by clicking the “Saved Transects” button. If you see an error message when submitting a
transect, check all of the tabs to make sure that you've entered all required data. This is
the most likely reason that you would receive an error message when submitting a
transect. If after checking through your data you are still unable to submit the transect and
you cannot figure out the problem, contact your crew leader.

V. Troubleshooting

You may encounter issues when loading data remotely or submitting data to the database. Look
below for commonly made errors, the error message you will receive, and how to correct the
error. If you come across an error not listed below, email your supervisor along with the error
message and they will instruct you on how to proceed.

1) Unable to load a survey remotely
You may run into a situation where you are unable to load a survey remotely. The most
common cause of this issue is that your Firefox browser cache is full. In order to clear
the cache, follow these steps:

A) Open up the data entry app in Firefox. Click on the options menu at the upper right
side of the screen. Select “Developer”, then select Web Console.

B) You will see a small screen at the bottom of the web page with a carrot (>) at the
very bottom. Next to that carrot, type “window.localStorage.clear()” and hit enter.
Note that the S in Storage is capitalized. This should clear out the localStorage
cache in your browse, which is specifically where all the data entry app data is
stored.

C) Once you clear out your local storage, close your Firefox browser and reopen the
data entry application. You should be able to resume data entry or proofing as usual
at this point.
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2) Horribly Invalid Data
Error Message:

The transect visit submission failed!

Error: FAILED_DESERIALIZE

Text: The submission could not be deserialized (horribly invalid data): 1- is not a valid
value for Int16.

If you received this error, don’t panic and don’t take it personally. This message simply
means that there is a value entered into a field somewhere that the database cannot
accept. In this case, the value is “1-“. This probably should have been a “-1” instead.
Look at the value in the error message that isn’t valid, then look for that value entered
somewhere in one of the tabs. When you find it, correct it.

If instead of a value, you just see a blank (. . .(horribly invalid data): is not a valid value .
.. ), this indicates that there is a field left blank somewhere in the data and the database
won'’t allow this. Look for any blank fields that are supposed to have a value, and fill in
the value or enter -1.

Once you've corrected the issue, try to resubmit the data. If it still doesn’t work, contact
your supervisor.

3) Point doesn’t exist
Error Message:

The transect visit submission failed!

Error: POINTVISIT_PARSE_FAILED

Text: The PointVisit could not be parsed because the list of points in the database did
not contain the point 17 from the datasheet.

This message indicates you’ve somehow you entered a point in the Points Completed
tab that doesn’t actually exist in the database. In this case, someone entered a point 17
on a survey that only contains points 1 — 16. If you receive this message when
submitting your data to the database, navigate to the Points Completed tab and check
for a point number that may have been entered incorrectly. If there is a survey map
included with the data, look at that map to determine which points are legitimate.

If you find the error and correct it in the Points Completed tab, make sure you also
correct that error on the Veg and Bird data tabs as well, then resubmit the data.

If you still cannot find the error, email your supervisor with the error message.

4) Duplicate Points
Error Message:

Error: NEWVEG_INSERT_FAILED
Text: The insert into the NewVeg table failed: Violation of UNIQUE KEY constraint

'IX_NewVeg'. Cannot insert duplicate key in object 'dbo.NewVeg'. The duplicate key
value is (498830).
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This error message indicates that there is a point number duplicated in the vegetation
data tab. Navigate to this tab and check through all the point numbers wherever the
point numbers are listed. Make sure each of the point numbers is unique and matches
the datasheet. Correct any duplicate numbers and resubmit the data to the database. If
you are still unable to submit the data to the database, notify your supervisor.

Note: Make sure you check the Points Completed tab if you submit data to the
database but never receive a confirmation pop-up window that the data
successfully submitted to the database. If this happens to you, check the Points
Completed tab and make sure none of the points are duplicated there. If points are
duplicated on this tab but not on the Vegetation Data tab, then your data will not
submit to the database but you will not receive an error message.
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